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Wykorzystanie panelu operatorskiego rodziny SIMATIC HMI Basic Panels 

 
W poprzednim rozdziale przedstawiono przykład testujący wymianę danych w sieci Profibus DP z 

regulatorem Sipart DR24, przekształtnikiem częstotliwości Micromaster 440 oraz kasetą oddaloną 

I/O SLIO, gdy masterem w sieci jest sterownik VIPA 314 ST/DPM wraz z stacją operatorską z 

systemem SCADA (aplikacje InTouch). Systemy SCADA są jednak kosztowne i dość 

skomplikowane. Przedstawiony zostanie dlatego też przykład wykorzystania do celów wizualizacji i 

sterowania nadrzędnego urządzenia HMI jakim jest panel operatorski. Dotykowy panel operatorski 

KTP1000 Basic Color PN z rodziny SIMATIC HMI należy do paneli operatorskich serii „Basic 

Panels”, która obok serii „Comfort Panels” wprowadzona jest obecnie na rynek przez firmę Siemens. 

Panel ten przeznaczony jest do małych aplikacji przemysłowych, gdy nie ma konieczności 

korzystania ze skryptów i archiwowania zmiennych. Panel posiada ograniczoną funkcjonalność HMI 

ale umożliwia realizację takich funkcji stacji operatorskich, jak tworzenie systemów alarmowych,  

wykorzystywanie receptur czy wyświetlanie trendów. Komunikację z panelami umożliwiają złącza 

RS422/485 (wersja „Basic DP”) lub RJ45- Ethernet (wersja „Basic PN”). Ta ostatnia przeznaczona 

jest do komunikacji ze sterownikami rodziny SIMATIC S7 z portem komunikacyjnym Profinet. 

Chociaż serię „Basic Panels” opracowywano z myślą o wykorzystaniu ze sterownikami SIMATIC 

S7-1200, to można również z powodzeniem w przypadku nieskomplikowanych projektów 

automatyki stosować ją do współpracy ze sterownikami S7-300/400. 

Do wykonania przykładowej aplikacji posługiwano się narzędziem inżynierskim WinCC flexible 

2008 Compact. Jednak przyszłościowym narzędziem do programowania paneli operatorskich klasy 

SIMATIC HMI Basic Panels jest narzędzie WinCC Basic V11, wprowadzane obecnie w ramach 

środowiska programowego TIA Portal V11, jako opcja programu WinCC V11. Pozostałe opcje to 

WinCC Comfort V11, WinCC Advanced V11 i WinCC Professional V11 o rosnącej 

funkcjonalności, które oczywiście również mogą być użyte do konfigurowania paneli serii „Basic  

Panels”. W ramach TIA Portal V11 zawarte jest także narzędzie inżynierskie SIMATIC STEP 7 

V11. Jego opcje STEP 7 Basic V11 (dla S7-1200) jak i STEP 7 Professional V11 (dla S7- 

1200/300/400) posiadają zintegrowane z nimi narzędzie WinCC Basic V11. Należy wspomnieć, że 

już pierwsze opracowanie TIA Portal V10.5 zawierało narzędzie STEP 7 Basic V10.5 do 

programowania sterowników S7-1200 i paneli operatorskich „Basic Panels”. 

W przykładowej aplikacji programu dla panela operatorskiego utworzony będzie ekran, który 

pozwoli na: 

   odczytywanie i zapisywanie parametrów obszarów PZD i PZW oraz wpisywanie i odczyt 
nastaw (obszar „AKZ”) regulatora SIPART DR24, 

   sterowanie przekształtnikiem częstotliwości Micromaster M440 oraz odczyt wartości jego 

częstotliwości wyjściowej, 

   wyświetlanie statusu oraz wybranych sygnałów binarnych sterowników swobodnie 
programowalnych (węzłów lokalnej sieci ethernetowej). 

Na rys.8.17 przedstawiono układ do testowania wymiany informacji w sieci Profibus DP wraz z 

wizualizacją w systemie SCADA (aplikacje InTouch) oraz z panelem operatorskim KTP1000 (seria 

SIMATIC HMI Basic Panels). 

 
Przygotowanie panelu operatorskiego do pracy 

Po włączeniu zasilania panelu operatorskiego na jego ekranie pojawia się informacja dotycząca 

zainstalowanego oprogramowania, a po chwili ekran programu ładującego z trzema przyciskami 

dotykowymi Transfer, Start i Control Panel. Dwa szybko po sobie nastepujące dotknięcia przycisku 

Transfer pozwalają na uruchomienie z komputera transmisji projektu przygotowanego w programie 

WinCC flexible 2008 Compact (wykorzystuje się jeśli nie wybrano opcji Remote Control w Control 

Panel →Transfer →Transfer Settings). Użycie przycisku Start powoduje przejście do ekranu 
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startowego projektu. Zanim jednak będziemy się posługiwać tymi przyciskami powinniśmy 
skonfigurować panel wywołując przyciskiem Control Panel ekran konfiguracyjny. Przede 

wszystkim, aby zapewnić komunikację panelu ze sterownikami w sieci Profinet należy, używając 

okna Profinet settings, ustawić w zakładkach parametry takie jak np.adres IP, szybkość transmisji 

czy nazwę stacji. Można też odczytać adres MAC urządzenia. 
 

 
 

 

 

 

 

Przejście do ekranu startowego projektu wczytanego do 
pamięci panelu 

 

 
 

 

 

 

 

 

 

Dwukrotne, szybko po sobie następujące dotknięcie ikony OP na ekranie panelu powoduje 
pojawienie się ekranu OP Properties, którego kolejne zakładki dają możliwość ustawienia 

jasności ekranu, czasu opóźnienia pojawiania się ekranu startowego, wyświetlenia informacji o 

panelu i warunków licencyjnych. Zaznaczenie na ekranie Transfer Settings opcji Remote Control 

umożliwia uruchomienie transferu projektu z komputera, bez zezwolenia z panelu. 
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Ustawianie hasła dostępu 

Ustawianie czasu, po którym ekran 
jest wygaszany 

Załączanie/wyłączanie sygnału 

dźwiękowego 

 

 
 

Przygotowanie projektu (aplikacji użytkownika) 

Tworzenie projektu w programie WinCC flexible 2008 Compact może się odbywać przez 

wybranie zakładki Project →New lub Project →New Project with Project Wizard . Ta druga 

opcja wymaga wykonania kolejnych kroków. 
 

 

Zaczyna się od wyboru typu projektu. Wybór Small machine ogranicza nasz projekt do 

wykorzystania jednego panela operatorskiego. Aplikację tworzoną w WinCC flexible 2008 

Compact można zintegrować z projektem realizowanym w programie narzędziowym do 

programowania sterowników - STEP 7, który wcześniej powinien zostać zainstalowany w stacji 

inżynierskiej. Jest wówczas możliwość wykorzystania w aplikacji wspólnej bazy zmiennych. 

Nazwę tego projektu trzeba wskazać w oknie Integrate an S7 project. 
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Kliknięcie na ekranie komputera klawisza Next umozliwia wybór panelu i sterownika. Po 
wybraniu KTP1000Basic PN program ustala jedyny możliwy w tym wypadku rodzaj 

komunikacji ze sterownikiem: Ethernet. 
 

 

Następnie wybiera się wzór ekranu. W linii nagłówkowej ekranu można wybrać obecność logo 

firmy, tytułu ekranu oraz bieżącej daty i czasu, rozpoczynając od lewej strony ekranu. Można 

także wybrać miejsce wyswietlania i kształt komunikatów o alarmach. 
 

Można skonfigurować także połaczenia między ekranami dla celów nawigacyjnych oraz ekrany 
systemowe. 
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Istnieje też możliwość ustalenia zawartości biblioteki wykorzystywanej do opracowania aplikacji 

(w tym także dołączania bibliotek zewnętrznych). 
 

 

Na zakończenie można umieścić informacje dotyczące opracowywanego projektu. 
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Po zakończeniu ścieżki czynności wytyczonej przez opcję New Project with Project Wizard 
ukazuje się drzewo projektu. Drzewo to zawiera wszystkie zadeklarowane wczesniej ekrany. 

Należy więc albo na etapie deklaracji wybrać tylko potrzebne elementy. Nie jest to wersja 

ostateczna, bo można potem dodawać lub kasować ekrany, a także zmieniać ich nazwy. Niżej 

pokazano drzewo opracowywanego projektu, które zawiera ekrany zatytułowane StopRuntime i 

Wizualizacja. Wybranie na drzewie projektu opcji Device Settings pozwala wybrać ekran, który 

będzie ekranem startowym projektu. W tym przypadku jest to ekran StopRuntime. 
 
 

 

Wybierając Communication →Connections można określić sterowniki współpacujące z panelem 

jako klientem w sieci Ethernet. 
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W zastosowanym w przykładzie sterowniku S7-200 z jednostką centralną CPU 224 REL 01.22 
komunikacja w sieci Ethernet odbywa się z wykorzystaniem modułu CP 243-1 IT. 

Konfigurowanie tego modułu odbywa się za pomocą programu narzędziowego STEP 7- 

Micro/WIN V4. W przykładzie zastosowano Wizard/Internet, natomiast obecny w menu 

Wizard/Ethernet pomaga skonfigurować moduł CP 243-1. Poniżej pokazano drzewo z wynikiem 

zastosowania opcji Wizard/Internet, a dalej kolejne kroki prowadzące do tego stanu. Bardzo 

pomocne przy tym korzystanie z dobrze opracowanego materiału dostępnego przez klikniecie 

ikony Click for Help and Support. 
 

 

 

Na pokazanym niżej ekranie można wpisać pozycję modułu komunikacyjnego w sterowniku lub 

zostanie ona automatycznie wykryta po podłączeniu się do sterownika. Podczas ustanawiania 

połączenia Connection 2 z panelem operatorskim jedyną możliwą (domyślną) pozycją jest 0. 

Następny krok to zadanie adresu IP, z maską podsieci i adresem bramy. 
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Wybiera się też adres bajtu sterującego modułu komunikacyjnego, który jest związany z 

numerem pozycji w sterowniku. W tym przypadku jest to QB2 bo bajty zerowy i pierwszy 

wykorzystywane są w jednostce centralnej posiadającej zintegrowane wejścia /wyjścia. Ponieważ 

nie liczy się połączenia sterownika z programatorem (STEP 7-Micro/WIN V4) w konfiguracji 

ilości połączeń komunikacyjnych S7 ustawiono ich liczbę na 1. Zadeklarowano, że sterownik w 

tym połączeniu będzie serwerem oddalonego klienta. Wymiana w protokole ISO_on_TCP 

korzysta z adresowania wykorzystującego punkty TSAP ( Transport Services Access Point ). Jest 

to konfiguracja jednostronna ( tylko w sterowniku – serwerze) z adresem TSAP=02.00, gdy 

zaznaczy się, że serwer będzie połączony z panelem operatorskim. Ten sam adres TSAP 

wpisujemy dla oddalonego klienta (panelu operatorskiego). 

  

Pozostałe elementy konfiguracji np.korzystanie z sumy kontrolnej, ustawianie identyfikatora 

administratora i hasła, korzystanie z dodatkowych funkcji internetowych (e – mail, klient FTP, 

obsługa HTTP), adres początku bloku danych konfiguracyjnych w wewnętrznej pamieci 

sterownika, na koniec wyświetlane są podprogramy wygenerowane przez Wizard/Internet. 
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Wygenerowane przez Wizard/Internet 
podprogramy są dostępne poprzez Call 

Subroutines w drzewie projektu. Po otwarciu 

głównego bloku OB1 sterownika można 

techniką „przeciągnij i upuść” umieścić 
podprogram z drzewa w tym bloku. Jeśli 

chcemy, by pojawił się przy tym opis 

podprogramu z podanym znaczeniem 

zmiennych, których adresy należy zadać - 

trzeba wybrać podprogram przez Wizard w 

drzewie projektu. Poniżej zamieszcono 

przykład wywołania podprogramu ETHO- 

CTRL. 
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Po skonfigurowaniu modułu komunikacyjnego CP243-1 IT i przygotowaniu oprogramowania 

sterownika, należy program zapisać, a następnie skompilować wybierając PLC → Compile All. 

Jeśli komunikat wyświetlany w oknie dostępnym przez wybranie View →Frame →Output 

Window informuje o pomyślnym zakończeniu kompilacji należy nawiązać komunikację ze 

sterownikiem w sposób pokazany na dwóch zrzutach ekranów zamieszczonych poniżej. 
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Następnie przesłać skompilowany program: File →Download. 
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Na zakończenie koniecznie zresetować sterownik: PLC →Power-Up Reset. Pomyślna realizacja 

tego polecenia sygnalizowana jest komunikatem Power-Up Resets was successful. 

Moduł CP 243-1 IT umożliwia korzystanie z funkcji Webserwera. W przeglądarce internetowej 

należy wpisać adres IP modułu (w przykładzie 156.17.40.140). Firmowa strona internetowa 

zawiera już pewne aplikacje diagnostyczne i informacje. Użytkownik może dołączać własne 

aplikacje z wykorzystaniem biblioteki apletów języka Java dostarczanych przez firmę Siemens. 

Poniżej pokazano stronę z wybraną aplikacją Rack status. Można nie tylko monitorować wartości 

wybranych zmiennych ale też je zdalnie ustawiać, wybierając aplikację Status Chart. Opcja ta 

chroniona jest hasłem podanym podczas konfiguracji modułu. 

 
 

Sposób przygotowania sterowników VIPA 300S i SIMATIC S7-300 do pracy w sieci wymaga 

jedynie podania adresów internetowych w programie Hardware Config (podprogram w STEP7 v. 

5.5). Konfigurowanie sterownika SIMATIC S7-300 pokazano poniżej. 
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Wykorzystując opcję Communication → Tags można zdefiniować używane w projekcie zmienne 

w oprogramowaniu sterowników pracujących w sieci. 
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Konfigurując    połączenie     panela     operatorskiego     ze     sterownikami     (Communication 
→Connections) wprowadzano wszystkie dane ręcznie. Jeżeli wcześniej dokonano integracji z 

projektem opracowanym w programie STEP 7 to uzyskuje się je automatycznie. Dla ilustracji 

zlikwidowano połączenie „Connection_1” ze sterownikiem VIPA_314ST (w wykazie połączeń 

figurujący jako SIMATIC S7 300/400 o adresie IP 156.17.40.142). Wywołując Project → 

Integrate in STEP 7 dokonuje się integracji z wybranym projektem w STEP 

7(VIPA_SLIO_MM4_SIPART). 
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Po zakończeniu integracji wywołujemy SIMATIC Manager. W drzewie projektu jako urządzenie  
pojawia się nowy obiekt Device_1 odpowiadający naszej aplikacji w WinCC flexible 2008 

Compact. 
 

 

Podwójne kliknięcie w ikonę Configuration otwiera pokazane poniżej okno podprogramu HW 

Config, które służy do ustawienia adresu IP urządzenia HMI IE oraz wybrania podsieci Industrial 

Ethernet, do której podłączony jest również sterownik. 
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Po powrocie do drzewa projektu i 

podwójnym kliknięciu ikony 

Connections uruchamia się program 

WinCC flexible, z otwartym ekranem 

Connections w zakładce 

Communication. W tablicy pojawiło 

się nowe, kolejne połączenie 

nieaktywne -„Connection_4” z 

przypisanym automatycznie adresem 

IP sterownika pobranym z projektu w 

STEP 7. Ponieważ zmienne ze 

sterownika VIPA w tablicy Tags 

przypisane zostały połączeniu 

„Connection_1” można powrócić do 

tej nazwy po uaktywnieniu (zmiana z 

Off na On). 
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Projekt przewiduje wykorzystanie dwóch ekranów na panelu 

operatorskim StopRuntime i Wizualizacja, przy czym 

StopRuntime jest ekranem startowym. Fragment ekranu z prawej 

strony pokazuje narzedzia (Tools),dostępne podczas tworzenia 

widoku ekranu na panelu. Dostęp do narzędzi może być poprzez 

okienko Tools o stałej obecności lub chowające się (gdy ikona 

„lizak” jest w pozycji poziomej). 

Jeśli skorzystamy z opcji Button możemy umieścić na ekranie 

klawisze o konfigurowalnych funkcjach i sposobach działania. 

Umieszczonemu na ekranie startowym klawiszowi StopRuntime, 

przypisano funkcję wyłączenia trybu Runtime i wywołania 

ekranu programu ładującego z przyciskami dotykowymi 

Transfer, Start i Control Panel.. 
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Na ekranie jest także sześć przycisków 

służących do ustanowienia (włącz/wyłącz) 

połaczeń komunikacyjnych pomiędzy 

sterownikami a panelem operatorskim. 

Sposób przypisania realizowanych przez nie 

funkcji pokazuje ekran obok. 
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Klawisz umieszczony w prawym dolnym 
rogu ekranu służy do wywoływania kolejnego 

ekranu o zadeklarowanej nazwie. 

Podobną funkcję można przypisać jednemu z 

klawiszy funkcyjnych F1-F8 panelu 

operatorskiego. 

 

Poniżej pokazano wygląd ekranu Wizualizacja, który zawiera podobne elementy jak opisany w 

8.3.2.4 przykład wykorzystania pakietu InTouch tzn. elementy sygnalizacyjne, przyciski 

sterownicze, pola odczytowe, pola odczytowo-wpisowe. 
 

 

 

Ponieważ panele operatorskie serii SIMATIC HMI Basic Panels nie dają możliwości korzystania  

ze skryptów, wszystkie przeliczenia danych do postaci porządanej przy wizualizacji muszą być  

wykonane w sterowniku. Poniżej zamieszczono przykładowe przeliczenia dla wybranych 

danych, o które należy uzupełnić pokazane w przykładzie 8.3.2.3 oprogramowanie stacji master. 
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Na ekranie poniżej przedstawiono sposób konfigurowania pola odczytowego do wyświetlania 
wartości zadanej regulatora Sipart, która wpisywana jest z zadanika prądowego na wejściu 

analogowym stacji master sieci Profibus, na polecenie wydawane klawiszem oznaczonym M5.0. 
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Konfigurowanie klawisza tzn. przypisanie zmiennej i jej typu, koloru w zależności od stanu, 

sposobu działania klawisza. 
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Na ekranie poniżej pokazano sposób konfigurowania pola odczytowo-wpisowego dla zmiennej 

cP-nastawa – współczynnik wzmocnienia regulatora. 
 

 

 

 

 

Konfigurowanie elementu sygnalizującego stan zmiennej bitowej ST12_0 (stan wyjścia 

binarnego SbA1 regulatora Sipart DR24) pokazano poniżej. 
 

Na następnym ekranie pokazano konfigurowanie klawisza umożliwiającego przejście z ekranu 

Wizualizacja do ekranu startowego StopRuntime. Taka samą funkcję przypisano przyciskowi F1 

panela operatorskiego. Skonfigurowanie klawisza funkcyjnego sygnalizowane jest żółtym 

trójkącikiem w dolnym, prawym rogu symbolu klawisza. 
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Po przygotowaniu programu należy go skompilować. Aby można było obejrzeć wynik trzeba w 

zakładce View kliknąć Output, by otworzyło się okno o tej nazwie, lub też kliknąć Output na 

którymś z pasków otaczających pole robocze, jeśli wcześniej zostało ono tam zadokowane. 

Kompilacji dokonuje się przez wybór Project → Compiler → Generate. Jeśli kompilacja 

powiedzie się można aplikację przesłać do panelu lub sprawdzić przez uruchomienie w 

symulatorze. 

 



26 Sieć Profibus DP w praktyce przemysłowej  

Czynności konieczne do dokonania transferu programu do panela operatorskiego ilustrują ekrany 
poniżej. Należy zwacać przy tym uwagę na pojawiające się komunikaty np. komunikat o 

nieodpowiedniej wersji firmware’u w panelu operatorskim. Pojawiają się przy tym wskazówki 

ułatwiające rozwiązanie problemu. 

 

. 

 

Operacje wykonane na panelu i 

skutkujące zmianami wartości zmiennych 

w sterowniku można obserwować w 

tablicy VAT uruchamianej w programie 

Step7 v5.5 ( PLC → Monitor/Modify 

Variables). Tablica ta pozwala także 

modyfikować wartości zmiennych. 

Oprogramowanie panelu można 

sprawdzać rónież nie posiadając jeszcze 

panela operatorskiego lub nawet 

sterownika. Wybór opcji Project → 

Compiler → Start Runtime powoduje 

odtworzenie ekranu panelu na ekranie 

monitora w trybie runtime tzn. z pełną 

jego funkcjonalnością w połączeniu ze 

wszystkimi sterownikami w sieci. 
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Wybór opcji Project → Compiler → Start Runtime with Simulator powoduje odtworzenie ekranu 

panelu na ekranie monitora w trybie runtime z jego funkcjonalnością, z tą różnicą, że zmienne 

pobierane są z tablicy symulatora. 



28 Sieć Profibus DP w praktyce przemysłowej  
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DAServer SIDirect 
 
 

LAN 192.168.22.20 
255.255.255.0 

 
 
 

 
WAN 

156.17.40.141 

156.17.40.140 

 
156.17.40.139 

 

 
156.17.40.137 

MCC 
 

192.168.22.3 

 

NAT 
IP adress   156.17.40.139 

maska podsieci 255.255.255.248 
156.17.40.142 
156.17.40.138 

 
 HOP.ICT.PWR.WROC.PL 

ETH 
MPI PB-DP 

 
SWITCH 

gateway 
DNS 

156.17.40.137 
156.17.42.30 

2 2 
DNS 156.17.5.2 

MASTER 
RS-485 

 
 
 
 
 

 
 

 

 

 

 
192.168.22.140 

 
 
 

 

PROFIBUS-DP 

Terminal magistrali RS485 

Sinec L2 6GK1500 - 0AA00 

N 

L 

 

 
 

MICROMASTER 440 
P ~ F 

 

 

 

 
 

+
24v 

-
 

+ 
- 
4...20 mA 

 

 
 
 
 
 
 

 

 
 
 

Kaseta I/O SLIO 

 
Industrial Ethernet 

 
 

PROFIBUS-DP 

Terminal magistrali RS485 

Sinec L2 6GK1500 - 0AA00 

 

SLAVE#10 

 
BE1 

BE2 

BE3 

BE4 

+24V 

 
SIMATIC S7-300F 

CPU  SM SM 

315F-2PN/DP 

 

 
ETH 

DP 

 

 
192.168.22.130 

 

 
SCALANCE 

 
SIMATIC ET200S 

 
 

 

 

 
 

 

 
In Touch 10.0 

"Rejestrator" 

 

 
 

 
 
 
 
 
 
 
 
 

Koncentrator sygnalow (GE-Fanuc 90/30) 

I 
0...20 mA 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Zasilacz 
24V= 

 
AE2 

 
 
AE4 

 
 
 
 
 
 
 
 

 
+ 

 
- 

 

 
SIPART DR24 

M  BA2 BA1 

 
 
 
 

Sterownik     3 

mocy 
15

 

RI3 10 

 
 
 
 
 
 
 
 
 
 
 
 
 

Wejście 
analogowe 

Obciążenie 
..230V~. 

 
 
 
 
 
 
 
 
 
 

 
U~ 

0 ..5V 

I~ 

 
"CENTRUM" - AI2 + - AI1 + 

4...20ma 

 
+ 230V~,50Hz 

 
Przetwornik  I 
pomiarowy R 

 
Piec 

 
 

Pt100 

 
 

Pt100 

 
 

M 

Rys.8.17. Układ do testowania wymiany informacji w sieci Profibus DP (przykład 8.3.2) 

- 

AIN2 

(PN + Safety) 

X208 
192.168.22.133 

"SIMATIC" 

12 

 

5 

6 

7 

8 

28 

SLAVE#8 

DIN4 

"0 V" 

DIN3 

DIN2 

DIN1 

0...20 mA 

I 

I 
P 

SM 

AI2 

SLAVE#16 

192.168.22.134 

ETH 

PS 

192.168.22.132 

ROUTER 
SM 

Simatic S7-200 
CPU224  CP243-2   EM235 

+
 

+
 

+
 


